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A
P Y T H O N M A N U A L

a.1 introduction

This document is written in collaboration between the group of
Michael Simonsen & Stefan Madsen, and Shuo Hua. It serves as a
part of their master thesis. This document describes the installation
and workings of an OS for LEGO® MINDSTORM EV3, called ev3dev
[61]. As well as descriptions of some initial programming experiences
with Python for the EV3 system. The software packages described
are the ev3dev kernel version 18 [133] and the Python library python-
ev3dev version 0.8.1 as of 17th of February 2017 [137].

a.2 the ev3dev operating system

The ev3dev is a Debian Linux-based OS for the LEGO® MIND-
STORM EV3 system. The ev3dev works as a standalone OS that
can be booted from external storage on EV3 e.g. a Secure Digital
card (SD card). There is no need for flashing the original EV3 internal
memory and OS that comes with the EV3. The ev3dev OS gives the
ability to program the EV3 with different programming languages
such as Python, Javascript, GO, C and C++, for which there already
exist libraries that assists in controlling the EV3 system [58]. Since
ev3dev is a full Linux backend, it’s also possible to extend current li-
braries to accomplish additional goals. The ev3dev OS is also capable
of running on platforms like Raspberry-Pi, though this topic will not
be covered by this appendix.

a.2.1 Installing the ev3dev OS

The guide to getting started with the ev3dev OS can be found at [59].
To get started a microSD or microSDHC card is needed with a storage
size between 2GB and 32GB to store the ev3dev OS [108]. APCwith
a SD card adapter and card-reader are needed to flash the ev3dev OS

onto the microSD or microSDHC card. The card reader can be internal
or external.

1. Download the ev3dev Linux distribution from [126].

2. Use a program like Etcher as suggested by [59] to flash the
SD card with ev3dev.
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Figure A.1: Brickman, the GUI for ev3dev.

Figure A.2: A SanDisk 32 GB HC MicroSD and a Netgear N150 - WNA1000

Wi-Fidongle in front of their respective ports on the EV3.

3. Once the SD card is flashed, plug it into the EV3, see Figure A.2,
and turn on the EV3.

On the first boot the new OS will do some initial setups, which might
take a few minutes, but subsequent boots are faster.

When the initial setup is completed, the ev3dev OS will start the
ev3dev’s GUI Brickman [138], and the installation of ev3dev OS is com-
plete, Figure A.1.

Once the ev3dev OS is booted, a connection between EV3 and the
PC has to be established. There are several options to choose from,
USB, Bluetooth and Wi-Fi, see Figure A.3. Through these connections
full Internet connectivity can be established on the EV3, if Internet
connectivity is not required, tethering [128, 129], which only allows
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Figure A.3: There are three options to connect the EV3 from a PC: Wired
USB, Bluetooth and Wi-Fi.

for local communication see Section A.2.1.2, can be used with these
options as well.

a.2.1.1 Establish Internet connectivity on the EV3

With Internet connectivity the EV3 becomes a full blown part of the
Internet of Things (IoT) [98], and it enables various TCP/IP connec-
tions [99] for communicating with the EV3. Also it allows for updat-
ing the ev3dev OS [60] without having to flash the SD card all over
again. The EV3 can be connected to the Internet either with a Wi-
Fidongle or by connecting it to a PC via USB or Bluetooth and then
sharing the PC’s Internet connection.

The simplest way to connect to the Internet, is to use a Wi-Fidongle
connected through the EV3’s USB port, see ??. See Section A.2.1.3 for
compatible Wi-Fidongles. Once the Wi-Fidongle is plugged in, use
the Brickman GUI, Figure A.1, Wireless and Networks → Wi-Fi menu to
connect to a network [57].

It is difficult to establish an Internet connection though Bluetooth
on Windows 10, due to the lack of documentation for Windows in-
stallations [125]. Instead a USB connection can be used and an In-
ternet connection can be established through it. For Linux and OSX
installations, it is quite straight forward to connect to the Internet, by
following the guides in [123, 124].

a.2.1.2 Tethering to a Host PC

If internet connectivity is not required, tethering can be used, but
this only allows to communicate and transfer files to the EV3 locally.
For Windows installations, one needs to join a Bluetooth personal net-
work in order to resolve the IP address correctly, there’s a guide about
that in [127], other than that the official documentation on tethering,
with both USB and bluetooth, is a bit sparse according to [128, 129].
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a.2.1.3 Wi-Fi dongles compatible with ev3dev

The recommended Wi-Fidongle by the LEGO® Group is the Netgear
N150-WNA1100 model [50], which is guaranteed to be compatible
with the standard OS running on the EV3 [39]. The N150-WNA1100

model is also one of several Wi-Fidongles recommended by ev3dev
developers for the ev3dev OS. Many other USB Wi-Fidongles which
support Linux will work too but are not officially supported by
ev3dev [57]. It was not possible to obtain the recommended dongle,
but it was possible to test the Proware PW-DN4210D Wi-Fi dongle [1]
that has the same chipset and wireless chip as the N150-WNA1100.
The Proware PW-DN4210D was confirmed working with the ev3dev
OS. The Netgear N150-WNA1000 Wi-Fidongle [49] was the closest
model to the Netgear N150-WNA1100 that was obtainable, it was
tested and confirmed working with the ev3dev OS without any issues.
The N150-WNA1000 dongle has a smaller size than the PW-DN4210D
and the N150-WNA1100 so it might be preferable over the two others.
Other Wi-Fidongles was tested and confirmed working i.e. the dongle
was inserted into the EV3, ??, and the EV3 could subsequently con-
nect to a wireless network and connect to the Internet through that
network, see Table A.1 for more information about the dongles.

Model Chipset Wireless chip Status

Netgear N150 - WNA1000 Atheros AR9001U-NG Atheros AR9170 Confirmed working

Netgear N150 - WNA1100 Atheros AR9002U Atheros AR9271 Not tested

Linksys WUSB100 v2 Unknown Ralink RT3070 Confirmed working

Proware PW-DN4210D Atheros AR9002U Atheros AR9271 Confirmed working

Table A.1: Wi-Fi dongles compatible with ev3dev OS. The different Wi-Fi
dongles are listed with the model name, the chipset [84], the
wireless chip and status of the current dongle running with the
ev3dev operation system. The dongles marked Confirmed working
have been tested as described in Section A.2.1.3.

a.3 remote terminal to the ev3

Once the EV3 is connected to a PC, as described in Section A.2.1.1 and
Section A.2.1.2, it might take a few minutes for the PC to discover the
host name of the EV3. If the PC is unable to resolve the host name
as ev3dev or ev3dev.local, then the local IP, which can be seen on the
EV3’s display, see Figure A.1, can be used as a substitute for the host
name.

By using the ev3dev OS standard login:

user name : robot

password : maker

host name : ev3dev or ev3dev.local
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Figure A.4: A terminal running on an EV3 with a host name changed to
blue-leader.
1. line: Starts the Python3 interpreter.
5. line: Importing the ev3dev-python-lang language bindings.
5. line: Getting an instance of the EV3 screen.
6. line: Setup the desired text in the upper left hand corner of
the screen.
7. line: Telling the EV3’s screen to update, after which the screen
on the EV3 will shortly display the text Hello World!.

A SSH connection [109] can now be established to remotely log into
the EV3 and start a remote terminal on the PC, see Section A.3.1 and
Section A.3.2 for how to do this on Windows and Linux/OSX respec-
tively.

The first time the PC makes a SSH connection to the EV3, a security
prompt concerning the authenticity of the host will be displayed on
the PC, this should just be answered with a yes.

Once logged on to a remote terminal running on the EV3, it is
possible to start the Python3 interpreter by typing python3 into the
terminal and hitting enter. In Figure A.4, it is shown how to use the
Python3 interpreter to quickly write a text to the screen on the EV3.

The small Hello World! example in Figure A.4 also highlights a prob-
lem regarding the screen on the EV3. The ev3dev OS comes with
a menu system called Brickman [138], and whenever a program or
a command wants to use the screen on the EV3, that program or
command is competing with Brickman for control. So when running
the commands in Figure A.4 the text Hello World! is potentially only
shown on the screen for a few seconds before Brickman retakes con-
trol. This issue and some different solutions are further discussed in
Section A.5.2 and Section A.5.7.

If multiple EV3’s are connected to the same network or PC, it be-
comes difficult to tell which EV3 the SSH session is connected to. To
alleviate this, the standard host name can be changed with a con-
figuration tool. To do so, first connect to the EV3 as described in
Section A.3.1 and Section A.3.2, then start the configuration tool by
running the following command in the remote terminal:
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sudo ev3dev−config

Figure A.5: The PuTTY [67] program setup to connect to the EV3 via the
ev3dev OS’s standard hostname: ev3dev on the SSH standard port:
22 [109].

a.3.1 Remote terminal on Windows

On windows a program like PuTTY [67] can be used to remotely
log onto the EV3. Pushing Open in Figure A.5 will open a terminal
window on the PC of a terminal running on the EV3.

a.3.2 Remote terminal on OSX/Linux

On OSX or Linux OS a SSH connection can be established directly from
a terminal [33]. Connect by using the host name ev3dev.local:

ssh robot@ev3dev.local

Running the above command will open a terminal window on the PC

of a terminal running on the EV3.
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a.4 uploading files to the ev3

Uploading files to the EV3 can either be done manually through scp
[110], e.g. using WinSCP [121] or directly from a terminal [81]. Al-
ternatively the EV3 can be setup as host of a git repository [20], or
the PyCharm Professional Edition Integrated Development Environ-
ment (IDE) can be setup to manage the deployment of files to the
EV3.

a.4.1 Git

Git [20] is er version control system, and the rest of this section as-
sumes that the reader already posses a basic understanding of Git
and how it works.

To setup the EV3 as host of a git repository, connect to the EV3 via
SSH, Section A.3, and execute the following commands in the remote
terminal to make sure that git is installed and up to date:

sudo apt−get update

sudo apt−get install git

git config −−global user.email "your@example.com"

git config −−global user.name "Your Name"

Then setup the project folder and initialise the git repository:

mkdir myproject.git

git init −−bare myproject.git

mkdir myproject

After setting up the project, edit the git’s post-receive hook [19] to
automatically deploy code pushed to the repository, by editing the
hook file in the text editor nano, which is pre-installed with the ev3dev
distribution.

nano myproject.git/hooks/post−receive

Add the following lines to the post-receive hook file, then save (Write-
Out) and exit. The second line deploys the project on the EV3, and
the last line gives all Python files execution permissions.

#!/bin/sh

git −−work−tree=/home/robot/myproject −−git−dir=/home/

↪→ robot/myproject.git checkout −f

chmod +x /home/robot/myproject/*.py

Finally the hook file needs to be made executable by:

chmod +x myproject.git/hooks/post−receive

The repository can now be cloned onto the local PC by using the
URL robot@ev3dev:myproject, see Figure A.6. On OSx and Linux it may
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Figure A.6: An example of cloning a repository from an EV3 running ev3dev
on windows using PyCharm.

Figure A.7: To add a new deployment server, choose SFTP and give it a name.

need to be robot@ev3dev.local:myproject or failing that, the IP from the
display can be used as a substitute for ev3dev.local, see Section A.3.

Once all this has been setup, assuming the PC and EV3 is on the
same network, then getting programs onto the EV3 is a matter of cre-
ating a commit and pushing it to the repository that has been created
on the EV3, and due to the edited hook file, all uploaded programs
will be given executable permissions, meaning the programs can be
run from Brickman, assuming the programs have a correct shebang.

a.4.2 PyCharm and deployment of files

PyCharm Professional edition can be set up to deploy files directly to
ev3dev [2]. First make sure the EV3 is turned on, then in PyCharm go
to Tools → Deployment → Configuration..., in the deployment win-
dow hit the plus sign in the upper left corner. In the add server win-
dow, Figure A.7, choose type SFTP[88] and give the new deployment
server a name.

In the next window, Figure A.8:

1. Enter SFTP host as ev3dev, unless host name has been changed.

2. Enter robot in user name.
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3. Enter maker in password

4. Hit Test SFTP connection to see if PyCharm can establish a con-
nection.

5. Push Autodetect to set the rootfolder.

6. Go to the Mappings tab.

Figure A.8: To setup a connection to a deployment server, e.g. an EV3 , enter
host name, user name and password.
(1) Host name of deployment server, ev3dev.
(2) Deployment server user name, robot.
(3) Deployment server password, maker.
(4) Test deployment server setup.
(5) Autodetect root folder.

In the Mappings tab, Figure A.9, the local path (1) has already been
set, assuming the correct project was open when starting the setup
process. Deployment path... (2) can be used if deployed files should be
placed in a specific folder on the EV3, hitting the button with three
dots (3) opens a view of available folders on the EV3.

In PyCharm going to Tools → Deployment → Options, Figure A.10,
the option Override default permissions on files (1) can be used to make
uploaded files executable, and in Upload changed files automatically...
(2) selecting On explicit save action, makes PyCharm upload a file to
the EV3 whenever the file is explicitly saved, e.g. File → Save All.
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Figure A.9: It is possible to choose a deployment folder.
(1) Local path should be set to project folder on the PC.
(2) Choose a specific folder on the EV3 to deploy files to.
(3) See a list of folders already present on the EV3.
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Figure A.10: In Deployment options, (1) files can be given executable per-
missions on the deployment server, and PyCharm can be con-
figured to (2) upload files when they are explicitly saved.
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Figure A.11: As ev3dev is a Linux based OS, when PyCharm deploys files to
the EV3 it needs to be told specifically to use Unix line separa-
tors.

To make files executable on the EV3 from a Windows machine, it
is necessary to choose Unix line endings, this is done by marking a
file in the project view, then File → Line Separators → LF. Or it can
be done for the entire project by going to settings, File → Settings...,
and under Code Style setting the line seperator to Unix and OS X, see
Figure A.11.

Now uploading files to the EV3 can be done from PyCharms
project view, by right clicking a file or folder, Deployment → Upload.

a.5 python on ev3

There exists two Python libraries for the EV3 system. The ev3dev-lang-
python [29] maintained by Ralph Hempel, is recommended by the
ev3dev team. The other one is python-ev3 [21], maintained by GongYi,
but according to [58] python-ev3 is either out of date, unfinished or
abandoned.

We have choosen to use ev3dev-lang-python as Python library, as it is
more stable and have documentation. The API of ev3dev-lang-python
can be found together with the documentation [32].

Generally the API is split into 3 groups of classes, that handles
the motor ports, sensor ports, and miscellaneous functions such as
display, sound and buttons. Every class of ev3dev-lang-python lies in
the ev3dev module and inherits from the base Device class.

• Motor classes [26]: These classes handles the action of mo-
tors connected through motor ports. For each kind of motor
connected, there exists different Motor class implementations,
such as ev3dev.core.ServoMotor or ev3dev.core.DcMotor. The mo-
tor classes are described in more detail in Section A.5.4.
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• Sensor classes [27]: These classes handles the received input
from sensors connected through sensor ports. For each con-
nected sensor it creates a LegoPort device to communicate
with it, and thus it is possible to customize sensors. For stan-
dard sensors shipped with the EV3 system, there already ex-
ists classes in the library such as ev3dev.core.TouchSensor or
ev3dev.core.LightSensor. The sensor classes are described in more
detail in Section A.5.5.

• Miscellaneous classes [25]: These classes provide functionality
and control to different part of the EV3 system, such as power
management, display, sound and remote control.

a.5.1 Developing Python programs for ev3dev using PyCharm IDE

A working environment for developing Python programs on ev3dev
can be setup by using the free version of PyCharm IDE or the Pro-
fessional version [55], which is free for students [18]. PyCharm is
a Python IDE made by JETBRAINS and can be downloaded from
[55]. The IDE provides helpful tools for coding Python, such as syntax
checking, code completion, built-in version control and many other
features. A tutorial for setting up PyCharm with ev3dev can be found
on [3].

The most important part of the tutorial is to install the site-package
python-ev3dev for Python3, as this is what allows the PyCharm IDE to
perform syntax checking and code completion.

The package can be installed through Pip Installs Packages (pip)
[135], a Python package manager [136], by running the following com-
mand in a terminal on the PC.

pip3 install python−ev3dev

To check for updated versions of the package, a pip upgrade com-
mand can be executed.

pip3 install −−upgrade python−ev3dev

a.5.2 Running a program

We have found 4 different ways of running a program on ev3dev [11].

1. Brickman

2. SSH

3. SSH and chvt

4. SSH, chvt and conspy

Each method is described in greater detail below.
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a.5.2.1 Brickman

Programs can be started directly from the EV3 using Brickman,
ev3dev’s standard menu system, by going to the File Browser, see Fig-
ure A.1, and navigating down to the program. This requires that the
program has been marked as executable on the EV3 by running the
following command in a remote terminal connected to the EV3, as
described in Section A.3:

chmod +x /home/robot/myproject/yourprogram.py

This requires the Python program file to contain a correct shebang
[89], which for python3 looks like:

#!/usr/bin/env python3

This method gives the program control over the screen and buttons.

a.5.2.2 SSH

Programs can also be run through the remote terminal once a SSH

connection to the EV3 is establish, as described in Section A.2.1. A
Python program can be explicitly run by the Python interpreter in a
remote terminal by the command:

python3 yourprogram.py

This does not require a shebang or the use of the chmod command,
as described in Section A.5.2.1 since the program is loaded with
python3.

A drawback to this method is that the program have to fight for
control of the screen with Brickman. The program is able to utilize the
screen, however, any output to the screen will disappear behind the
Brickman menu system fairly quickly, as described in Section A.5.1.

a.5.2.3 SSH and chvt

With a SSH connection to the EV3, as described in Section A.2.1, in the
remote terminal run the command:

sudo chvt 6

This changes the screen on the EV3 to a new terminal window, see
Figure A.12, one that Brickman does not use. However, as the new
window is still just a terminal this method still suffers from the prob-
lems described in Section A.5.7, except that the solution proposed
does not work with this method.

a.5.2.4 SSH, chvt and conspy

This is the best solution we have found to gain control over the EV3

screen. Like the method described above in Section A.5.2.3, first cre-
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Figure A.12: The EV3 screen once the terminal has been changed with the
chvt 6 command

ate a SSH connection and change the window to one not used by
Brickman, but for this method also use the command conspy [65]:

sudo chvt 6

sudo conspy

The conspy command will make the terminal window on the PC, Fig-
ure A.13a, mirror the terminal running on the EV3, Figure A.13b. This
way the problem and solution mentioned in Section A.5.7 will work,
as the OS commands used are now run directly on the terminal run-
ning on the EV3.

a.5.3 Remote procedure call

It is possible to set up RPC for Python in the ev3dev. This requires
installation of RPYC [62] on both the PC and the EV3. With RPYC the
EV3 can be set as a RPC server, which enables the execution of scripts
on EV3, that are stored in a remote position. This gives the ability
to perform distributed computing, where heavy computational tasks
can be run locally and then send the results to the remote which uses
these to execute some lightweight procedures [122].

To install RPYC on the EV3, run the following command in a re-
mote terminal, Section A.3:

sudo easy_install3 rpyc

While on PC it is

pip install rpyc

Afterward it is required to create a shell-script on the EV3 with the
following lines:
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(a) Local terminal mirroring terminal running on the EV3 after using first the chvt 6
and then the conspy command.

(b) Running terminal being shown on the EV3 screen after using
first the chvt 6 and then the conspy command.

Figure A.13: A terminal running on the EV3 can be mirrored in a terminal
running on a PC using the conspy command.
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#!/bin/bash

python3 ‘which rpyc_classic.py‘

And remember to give it the execution privileges with the chmod com-
mand.

chmod +x rpc_server.sh

By executing this shell-script, it initiates a classic RPC server, if suc-
cessful it should output something like:

INFO:SLAVE/18812:server started on [0.0.0.0]:18812

Then to execute scripts remotely, it is required to specify the connec-
tion to the RPC server by giving the host name or IP address. Then
import the core module from RPYC remotely, so the scripts should
look like the following:

import rpyc

conn = rpyc.classic.connect(’ev3dev’)

ev3 = conn.modules[’ev3dev.ev3’]

## your code ##

Since RPYC 3.0, it’s possible to define services that expose a well-
defined set of capabilities to the other party, which makes RPYC a
generic RPC platform. Such that RPYC can be setup as a server in the
traditional server-client architecture, rather than just a remote inter-
preter. A tutorial of how to achieve that can be found at [80].

a.5.3.1 Latency test on RPC

Like in all distributed systems, the system response time will be wors-
ened due to the latency introduced by the network connection, this
would limit the usefulness of the RPC, especially for systems where
reaction speed is essential [122].

To further investigate the effect of how the response time affects
the robot, a small experiment is conducted. The experiment lets a
EV3 robot equipped with a color sensor drive forward on a dark
surface, the robot stops when the color sensor detects a lighter surface,
while time is measured to see if there is a difference in running time
between a program stored on EV3, or a program issued through RPC.
The experimental code of both the locally stored program and the
RPC program can be found as Listing A.1 and Listing A.2.

Three experiments are conducted, one by direct bluetooth connec-
tion, another by Wi-Ficonnection through a local router, and one with-
out RPC. The results can be seen in Table A.2.

1 These numbers are severely affected by network traffic, thus the response time is
inconsistent. The number showed here are the best results obtained. It is advised to
establish a direct Wi-Fi connection between the EV3 and the local machine instead.
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#!/usr/bin/env python3

from ev3dev.ev3 import *
import time

#initialis the motor and sensor devices

left = LargeMotor(’outB’)

right = LargeMotor(’outC’)

sensor = ColorSensor(’in1’)

#notify that initialisation is completed and get the

↪→ start time in ms

Sound.tone([(440,100)])

st = time.time() *1000

#get the time before starting the left motor

t1 = time.time() * 1000
left.run_forever(speed_sp=300)

#timing the execution of the statement above

left_t = time.time() * 1000 − t1

#get the time before starting the right motor

t2 = time.time() *1000
right.run_forever(speed_sp=300)

#timing the execution of the statement above

right_t = time.time() * 1000 − t2

#the exit statement

while not Button().enter:

if sensor.reflected_light_intensity > 50:

left.stop()

right.stop()

break

# get the end time in ms and notify the end of program

et=time.time() *1000
Sound.tone([(440,50) ,(220,100)])

#print the results to the console

print(’time used on starting the left motor: {}’.format

↪→ (left_t))

print(’time used on starting the right motor: {}’.

↪→ format(right_t))

print(’running time: {}’.format(et−st))

Listing A.1: The experimentation code of the locally stored program
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#!/usr/bin/env python3

import rpyc

import time

#initialise the RPC connection

conn = rpyc.classic.connect(’192.168.1.103’)

ev3 = conn.modules[’ev3dev.ev3’]

#initialis the motor and sensor devices

left = ev3.LargeMotor(’outB’)

right = ev3.LargeMotor(’outC’)

sensor = ev3.ColorSensor(’in1’)

#notify that initialisation is completed and get the

↪→ start time in ms

ev3.Sound.tone([(440,100)])

st = time.time() *1000

#get the time before starting the left motor

t1 = time.time() * 1000
left.run_forever(speed_sp=300)

#timing the execution of the statement above

left_t = time.time() * 1000 − t1

#get the time before starting the right motor

t2 = time.time() * 1000
right.run_forever(speed_sp=300)

#timing the execution of the statement above

right_t = time.time() * 1000 − t2

#the exit statement

while not ev3.Button().enter:

if sensor.reflected_light_intensity > 50:

left.stop()

right.stop()

break

# get the end time in ms and notify the end of program

et = time.time() *1000
ev3.Sound.tone([(440,50) ,(220,100)])

#print the results to the console

print(’time used on starting the left motor: {}’.format

↪→ (left_t))

print(’time used on starting the right motor: {}’.

↪→ format(right_t))

print(’running time: {}’.format(et−st))

Listing A.2: The experimentation code of the remotely stored program
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Figure A.14: The response time experiment setup

Connection type total running time latency between commands

Local ∼3000 ms ∼20 ms

Bluetooth ∼3500 ms ∼100 ms

WIFI1 ∼5000 - ∞ ms ∼40 - ∞ ms

Table A.2: Results of the response time experiment

The results show that the network latency introduced by RPC af-
fects the response time severely. Not only does the latency make the
robot react slowly, but the latency between each command affects the
robots behavior. During the experimentation, as to move the robot for-
ward, the robot starts its left motor before the right motor as shown in
Listing A.3. But it is observed that during RPC, due to the latency, this
have resulted in the robot twitching a little to the right side before
going forward.

a.5.4 Python program controls motors

There are five motor classes in the API [32]. The class
ev3dev.core.Motor controls a motor using the tacho counter, the
speed of the motor has to be set before or on calling a command
by setting the speed_sp attribute. The speed unit is tacho count per
second where the LEGO® motors use degree per second, this can
be converted by using the count_per_rot attribute. A negative speed
value will cause the motor to rotate in reverse except in the run-to-
position commands, which uses the absolute value of the speed_sp at-
tribute. The maximum speed value that can be set depends on which
type of motor is connected, use the property max_speed to get the
maximum value that is accepted by the speed_sp attribute. If a value

left.run_forever(speed_sp=300)

right.run_forever(speed_sp=300)

Listing A.3: Method run_forever used in testing RPC latency
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m = Motor(OUTPUT_B)

# Print the motors max speed

print("max speed {0}".format(m.max_speed))

# Set motor to run at max speed for 3000 milliseconds

m.run_timed(time_sp=3000, speed_sp=m.max_speed)

# Block as long a motor is running (3000 miliseconds)

m.wait_while("running")

Listing A.4: Example of running a motor for a set amount of time.

m = Motor(OUTPUT_B)

# Start motor at max speed

m.run_forever(time_sp=m.max_speed)

# Wait for back button to be pushed

while not btn.backspace:

sleep(0.01)

# Stop the motor

# This has to be done explicitly, otherwise the motor

↪→ will continue running, even after program

↪→ termination

m.stop()

Listing A.5: Example of running a motor until it is explicitly stopped.

greater then max_speed is assigned to speed_sp the motor class will
throw an exception. The maximum speed value is a theoretical max-
imum speed and can differ slightly from the actual maximum speed
of a particular motor. The motor class uses a PID regulation [103] to
maintain the correct speed, as defined by the speed_sp attribute. The
motor class provides a low-level control over the motor in general,
where parameters can be tweaked and information about the current
state of the motor can be retrieved, e.g. instead of setting the speed_sp

attribute it is possible to set the duty_cycle_sp [105] attribute instead,
see an example in Listing A.6.

The two different motor classes ev3dev.core.LargeMotor and
ev3dev.core.MediumMotor serves the purpose of loading the right
drivers for the EV3 large motor and EV3 medium motor respectively,
and both use the ev3dev.core.Motor class described above to control
the motor.
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motor = Motor(OUTPUT_B)

motor.duty_cycle_sp = 0

motor.run_direct()

for x in range(0,100):

sleep(1)

motor.duty_cycle_sp = x

sleep(3)

motor.duty_cycle_sp = 0

Listing A.6: Example of using the low level duty_cycle_sp attribute and the
run_direct() method. Slowly ramps up the duty cycle from 0%
to 100% over 100 seconds.

The class ev3dev.core.DcMotor provides a simple interface for us-
ing a regular DC motor this includes the LEGO® MINDSTORMS
RCX motors and the LEGO® Power Functions motors. The class does
not provide complicated controls or feedback. Similar to the speed_sp

attribute in the motor class a duty_cycle_sp attribute has to be set,
this sets the PWM signal [105] sent to the motor, then the motor can
simply be started and stopped. Using a DC motor is almost identical
with the example in Listing A.6, but older DC motors cannot be auto
detected by ev3dev, so it is necessary to explicitly tell ev3dev that a
DC motor is connected to a specific port [28], and after the DC motor
is initialised it is necessary to wait a second before attempting to set
any of the attributes or running any of the methods. This is probably
related to the way ev3dev handles motors and sensors, i.e. ev3dev
uses the file system to control sensors and motors, so these files need
time to be created. The example in Listing A.7 has the same effect on
a DC motor as Listing A.6 has on a standard EV3 motor.

The last motor class is ev3dev.core.ServoMotor which can be used
for hobby type servo motors, more information about this class can
be found in the documentation [32].

a.5.4.1 Motor.wait_while(’running’)

The EV3 motor has a method wait_while(s), [30], which blocks
as long as the motors state includes s, so this could be used like
Motor().wait_while(’running’) to wait for a motor to stop running.
However due to the way this has been implemented, see Listing A.9,
it can block program execution even though the motor is not running,
e. g. running the code in Listing A.8 will block even though the motor
is not running.
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# Tell ev3dev a DC motor is connected to port B

port = LegoPort(OUTPUT_B)

port.mode = "dc−motor"

motor = DcMotor(OUTPUT_B)

# Wait for system files to be created

# In our experience, not waiting causes an exception to

↪→ be thrown

sleep(1)

# Now the DC motor is ready to be used

motor.duty_cycle_sp = 0

motor.run_direct()

for x in range(0,100):

sleep(1)

motor.duty_cycle_sp = x

sleep(3)

motor.duty_cycle_sp = 0

Listing A.7: Example of using an older DC motor. Slowly ramps up the
speed from 0% to 100% over 100 seconds.
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from ev3dev.ev3 import Motor

Motor().wait_while(’running’)

Motor().wait_while(’running’)

Listing A.8: On a freshly added motor, i. e. the motor has received no other
commands, running this code will make the second wait_while
block until the motors state file is changed.

The wait_while(s) method is a wrapper that uses the wait(cond)

method, so the problem originates in the wait(cond). Specifically the
problem occurs because the implementation utilizes that hardware
access in ev3dev happens through the file system. The poll method in
Listing A.9 waits for an I/O event on the motors state file, but it does
this before checking what the current state actually is, which leads to
the wait method blocking even though condition is already met.

def wait(self, cond, timeout=None):
...

while True:

self._poll.poll(None if timeout is None else

↪→ timeout)

if timeout is not None and time.time() >= tic +

↪→ timeout / 1000:

return False

if cond(self.state):

return True

Listing A.9: Lines 850-875 of core.py, is part of the wait method used
in wait_while(). The poll method blocks until an I/O event
happens on the underlying state file, and this happens without
first checking if the condition has been met. This means that if
the state file already meets the condition, then the wait method
will still block until the state file changes.

a.5.5 Python program using sensors

The API contains classes for all the LEGO® sensors, as documented
in [27, 32], and they are fairly well documented. All the sensor classes
are derived from the base class Sensor, which means that if you do not
like the formatted output of the special sensor classes, the raw values
can be extracted from the base class, e.g. by calling the value function.

The value function returns the value or values the sensor is cur-
rently measuring in the sensors current mode. The available modes
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colorSensor = ColorSensor()

colorSensor.mode = "RGB−RAW"

red = colorSensor.value(0)

green = colorSensor.value(1)

blue = colorSensor.value(2)

Listing A.10: Example of extracting the raw rgb values from a color sensor.

can be listed with the modes attribute, and the mode can be set by set-
ting the mode attribute. Different modes for different sensors might
have a different amount of sensor values, this can be determined by
reading the num_values attribute. So extracting the raw color values
from a color sensor can be done like in the example in Listing A.10.

One of the benefits of the EV3 is that the standard LEGO® sensors
identify themselves, meaning that if a robot only contains one sensor
of a specific type, there is no need to identify the port it is connected
to, which is why the code in Listing A.10 will work. If a robot does
have multiple sensors of the same type, then it is necessary to identify
the correct port, e.g. if two touch sensors are attached to ports 1 and
3 then it is required to initiate them as follows:

_left = TouchSensor(INPUT_1)

_right = TouchSensor(INPUT_3)

If a port has been specified and nothing is connected to that sensor
or motor port, then the program will throw an exception.

a.5.6 Reading values from hardware

Reading a value from hardware is not thread safe, even if it is a con-
stant like a motors count_per_rot attribute, and doing so can pro-
duce error like the two shown in Figure A.15.

A solution to this problem is to make a wrapper class, which en-
sures to protect access to attributes. Listing A.11 shows a wrapper
class for a color sensor, the class creates a lock object which is used
to protect access to the color attribute, meaning that as long as all
threads use the some instance of the PColorSensor it should not pro-
duce concurrency errors.

a.5.7 Python program using buttons

The button class is documented in [24, 32] and the code in List-
ing A.12, will wait for the user to push the back button before con-
tinuing, assuming the ev3dev is running at least kernel version 18,
18-ev3dev kernel [133], check this by going to the about menu in
Brickman on the EV3. On older versions button checks return true
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Figure A.15: Concurrently reading from a hardware attribute can causes er-
ror where it reads an empty file or file with 2 values in it, nei-
ther of which can be converted to an int.

class PColorSensor(ColorSensor):

SYSTEM_CLASS_NAME = Sensor.SYSTEM_CLASS_NAME

SYSTEM_DEVICE_NAME_CONVENTION = Sensor.

↪→ SYSTEM_DEVICE_NAME_CONVENTION

def __init__(self, address=None, name_pattern=

↪→ SYSTEM_DEVICE_NAME_CONVENTION , name_exact=

↪→ False, ** kwargs):
super().__init__(address, name_pattern ,

↪→ name_exact , ** kwargs)
self._lock = threading.Lock()

@property

def color(self):

with self._lock:

return super().color

Listing A.11: A thread safe wrapper class for a color sensor.

when the button is up, and false when it is down, but this has been
fixed in version 18 according to [134], so that button checks return
true when down.
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btn = Button()

while not btn.backspace:

sleep(0.01)

Listing A.12: Waiting for the back button to be pressed down.

#Wait for button down

while not _btn.enter:

sleep(0.01)

#Wait for button up

while _btn.enter:

sleep(0.01)

Listing A.13: Waiting for a button pressed, e.g. both pressed down and
released again, has to be done explicitly.

The Button class does not have a method to wait for a button press,
as in button both pressed down and released again, so if the intention
is to wait for user input before advancing a program, it has to be
done explicitly as in Listing A.13, or different buttons could be used
to advance the programs through different stages. An example of this
can be seen in the line follower discussed in ??, when the color sensor
is calibrated.

Also button inputs are not fully intercepted by a running program,
meaning that if a program is started from a remote terminal as de-
scribed in Section A.5.2.2, then any button input the program re-
quires, will also navigate the Brickman menu system. Or if a program
is started like described in Section A.5.2.3 and Section A.5.2.4, then
button presses will cause output to be written to the screen, as shown
in Figure A.16.

A possible workaround is to surround the Python program code
with some OS commands to turn off input and cursor, see Listing A.14.
This works when starting a program from Brickman or by the conspy
method described in Section A.5.2.4. The use of a try/catch/finally
block [16] in Listing A.14 ensures that the terminal works as usual
even if main() throws an exception.

a.5.8 Python program using LCD

Using the LCD display is not optimal and has room for improve-
ments, if a program is started from a terminal, then button input is
not intercepted fully by the program and so it writes these to the
screen, as also described above in Section A.5.7.
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Figure A.16: When a program is running on the EV3 button events are not
fully intercepted by the running program, but are also executed
in the terminal. This results in input showing up on the EV3

screen, as marked by the red boxes, when the buttons on the
EV3 are pushed.

if __name__ == ’__main__’:

try:

#Turn of blinking cursor and echo to avoid

↪→ printing

#button input

os.system("stty −echo")

os.system("setterm −cursor off")

main() # Your code in main()

finally:

#Turn on echo and cursor again

os.system("setterm −cursor on")

os.system("stty echo")

Listing A.14: A work around to better control the EV3 screen.
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from ev3dev.ev3 import *

#Get an object instance of the display

lcd = Screen()

#Clears the display

lcd.clear()

#Draws text on the display

lcd.draw.text((25,50),’Every thing is awesome’)

#Call update on the display to apply changes

lcd.update()

Listing A.15: A sample program printing a text to the screen on the EV3.

Figure A.17: Output from running the example in Listing A.15.

The EV3 has the capability of displaying 178 x 128 pixels on the
monochrome LCD. The top-left corner pixel has the coordinates {0, 0}
and the bottom-right pixel has the coordinates {177, 127} according to
[11]. Most of the interaction with the display is through a graphics
library called Pillow, which is a standard library in Python, see more
documentation of Pillow at [53].

There are two ways to display text on the display, since the pro-
grams runs in a terminal all functions that writes output to the termi-
nal will be displayed on the screen where the program was started, in
Python the print() function does that. The other way is to use the Pil-
low library to write text on given coordinates, where the coordinates
are the top left corner of the text. An example of a simple text written
to the display can be seen in Listing A.15 the output of which can be
seen in Figure A.17.

It is possible to save a screenshot of the current screen of EV3, by
running the command fbgrab <some-name>.png in a terminal con-
nected by SSH to the device, which produces an image as seen in
Figure A.18a. But the LCD itself is not white, but more of a green
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(a) Using the fbgrab

<some-name>.png command.
(b) Using the scr.py program from

[38].

Figure A.18: Screenshotting the EV3 LCD.

color, so [38] has a small program which takes a screenshot using
fbgrab and then changes all the white pixels to a green color, produc-
ing an output as in Figure A.18b, which is the method used in this
document.
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